Chapter 2

Getting Started with a
Structural Project

Learning Objectives

After completing this chapter, you will be able to:
* Start a new structural project
* Set the units of various measurement parameters for a project

* Understand the concept of snaps, dimensions, and object snaps
* Save a project

* Close a project and exit Revit 2022
* Open an existing project
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In this chapter, you will learn how to create a new structural project. Also, you will learn the
methods of creating initial setups such as units and snaps.

STARTING A NEW STRUCTURAL PROJECT

File Menu: New > Project
Shortcut Key: CTRL+N

In Revit, a structural project is considered as a single database containing information related
to a building design. This means that the project file created will contain all the information
related to building design, from geometry to construction documentation. Generally, this
information include the details of the components used to design building models (like walls,
doors, windows, beams, columns, and other relevant information about the building design),
different views of the model, working drawings created from model, and documentation related
to design of the model.

In Revit, you can create different views such as plan, elevation, and sections from a single model
created for a building project. These views are associated with each other. This means, when you
change the building design in one view, it is propagated throughout the project.

In Revit, a new project file uses the default settings that are defined in the project template.

To start a new project, choose New > :
Project from the File menu, as shown REzHG--- @ &-F0A @-0°
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Figure 2-2 The New Project dialog box

You can also save any project file as a template file. You can select a file as template by first
choosing the Browse button in the Template file area of the New Project dialog box and then
selecting the required file from appropriate location. To create a new project, select the Project
radio button and to create a template, select the Project template radio button in the New
Project dialog box.

Note
@ If you select the None option from the New Template drop-down list in the New Project dialog
box, a new project file will be created without a template file but with the default settings of Revit.

SETTING PROJECT UNITS

Ribbon: Manage > Settings > Project Units t‘ﬁ%i
Shortcut Key: UN

Project Units Whil¢ you start a B}Jilding Information Modeling project, setting project un.it.s is
very important as it provides a standard for measurement of different entities.

While installing Revit, you are prompted to set the Imperial (feet and inches) or Metric (meter
and millimeter) unit as default. Setting a default unit system helps you to start your project with
a specific type of unit as per the conventions followed in the industry. To set units, choose the
Project Units tool from the Settings panel of the Manage tab; the Project Units dialog box will
be displayed, as shown in Figure 2-3. Alternatively, type UN to display the Project Units dialog
box. Under the Units column in this dialog box, you can specify various units that are relevant
to the building project. In the Project Units dialog box, units are grouped into seven disciplines:
Common, Structural, HVAC, Electrical, Piping, Energy, and Infrastructure. Each discipline
has a set of measurement parameters. You can select any of these disciplines from the Discipline
drop-down list in the Project Units dialog box. The Format column in this dialog box displays
the current unit format for the corresponding parameter in the Units column. You can preview
and select the possible digit grouping and decimal separators from the Decimal symbol/digit
grouping drop-down list, which is at the lower left corner of the dialog box. Different types of
units and their parameters are discussed next.

Note

@ The values displayed in the Format column of the Project Units dialog box may differ depending
wpon the type of unit system, Imperial or Metric, selected for the project. In this textbook, the
Imperial and Metric unit systems have been used in tutorials and illustrations.
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Project Units *
Discipline: LCommon ine
Units Format ~
Angle 12.35°
Area 1235 m°
Cost per Area [S/ft] 1235
Distance 1235 [']
Length 1235 [mm]
Mass Density 1234.57 kg/m®
Rotation Angle 12.35°
Slope 12.35°
Speed 1234.6 kmm/h
Time 123465
Velume 123457 m*
Currency 1234.57
v
Decimal symbol/digit grouping:
123,456,789.00 e
cance =

Figure 2-3 The Project Units dialog box

Common Unit Type

The Common unit type used in a structural BIM project includes parameters such as angle,
area, length, mass density, slope, speed, time, volume, and currency. In the Project Units
dialog box, the Common option is selected by default in the Discipline drop-down list, refer
to Figure 2-3. The Common unit type used in Revit is similar to those used in other Revit
platforms. Moreover, the settings of the parameters of common units are similar to those used
in other CAD programs. The methods of setting various parameters under the Common unit
type are discussed next.

Setting Length Units

In a structural project, you can assign different units for the measurement of length. The length
units can be used to specify the length, width, thickness, and other linear measurements used
for structural and non-structural elements such as beams, columns, slabs, trusses, and others. To
define the length units, click on the field corresponding to the Length parameter in the Format
column of the Project Units dialog box; the Format dialog box will be displayed. This dialog
box displays the units of length and their settings, as shown in Figure 2-4. Select the required
unit from the Units drop-down list in the dialog box. The options that can be selected from
this drop-down list are Feet, Feet and fractional inches, US survey feet, Fractional inches,
Meters, Decimeters, Centimeters, Millimeters, and Meters and centimeters. By default, the
Feet and fractional inches option is selected in this drop-down list if the Imperial is selected
as the unit system at the time of installing Revit. But, if you have selected Metric as the unit
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system then the Millimeters option is selected in this drop-down list by default. The settings for
rounding increment for the length unit can be made from their respective drop-down lists and
edit boxes. To do so, select the desired option from the Rounding drop-down list. For certain
units, you can specify custom rounding value using the Rounding increment edit box which
is placed next to the Rounding drop-down list. This edit box is inactive by default. To make it
active, first select any option from the Units drop-down list and then the Custom option from
the Rounding drop-down list. Once the Rounding increment edit box is active, you can specify
the desired rounding value in it for the selected unit (the Custom option remains inactive for
the Feet and fractional inches, Fractional inches, and Meters and Centimeters options of the
Units drop-down list).

Note
The Rounding increment edit box is not available for the Meters and Centimeters, Feet and
Jfractional inches, and Fractional inches options.

Format ped
Use project settings
Units: Feet and fractional inches v

Rounding:

To the nearest 1/8" ~

Suppress trailing 0's
[ ISuppress 0 feet

Show + for positive values
Juse digit grouping

] Suppress spaces

Figure 2-4 The Format dialog box

The Unit symbol drop-down list will be inactive if any of the Feet and fractional inches,
Fractional inches, and Meters and centimeters options is selected in the Units drop-down list.

Once you make the Unit symbol drop-down list active, you can select the desired option
from it to specify the measurement symbol to be used along with the unit of length in a
project. For example, to use the symbol ‘m’ after all metric length measurements, you
can select m option from the Unit symbol drop-down list as the measurement symbol.
You can select the Suppress spaces check box to remove all spaces around the dash
from the length strings. For example, you can remove spaces around the dash when a
length string is expressed in feet and fractional inches to denote a particular measurement.

Note
The Suppress spaces is only active when Feet and Fractional inches is selected in the Units
drop down.
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Setting the Area and Volume Units

In a BIM proejct, the volume units the Project Units dialog box, you can assign a unit for the
measurements of areas. To do so, click on the field corresponding to the Area parameter in the
Format column of the Project Units dialog box; the Format dialog box will be displayed. In this
dialog box, you can set the unit for measuring the area by using the options in the Units drop-
down list. This drop-down list contains various options for the units of area such as Square feet,
Square meters, Square inches, Square centimeters, Square millimeters, Acres and Hectares.
By default, the Square feet option is selected in this drop-down list, if you had selected the
Imperial units at the time of installing Revit. But, if you have selected the Metric units then the

Square meters option is selected in this drop-down list by default. The settings for rounding
increment and unit symbol for the area units can be made from their respective drop-down lists.

Similar to set the units for the area, you can set the units for volume. To set unit for the volume
measurement, click in the field of the Format column corresponding to the Volume parameter
in the Project Units dialog box; the Format dialog box will be displayed. In this dialog box,
click in the Units drop-down list and select: Cubic yards, Cubic feet, Cubic meters, Cubic
millimeters, or Liters and so on. After selecting a suitable option from the Units drop-down
list, choose the OK button; the Format dialog box will be closed and the selected unit for the
volume measurement will be displayed in the field of the Format column corresponding to the
Volume parameter in the Project Units dialog box.

Setting Angle Units

In the Project Units dialog box, you can assign a unit for the measurement of angle. To do so,
click on the field corresponding to angle parameter in Format column of the Project Units
dialog box. The Format dialog box will be displayed. You can specify the unit for the angle by
selecting the required option from the Units drop-down list in the Format dialog box for the
Angle parameter. You can select Degrees, Degrees minutes seconds, Radians, or Gradians
from the Units drop-down list to specify the unit for the angular measurement. By default, the
Decimal degrees option is selected in this drop-down list, if Imperial is selected as a unit system
at the time of installing Revit. Similarly, 12.35° option is selected for Metric unit. The settings
for rounding increment for the angle unit can be made from their respective drop-down list
and edit box.

Setting Slope Units

In the Project Units dialog box, you can assign a unit for the measurement of slope. To do so,
click on the field corresponding to angle parameter in the Format column of the Project Units
dialog box. The Format dialog box will be displayed. You can specify the unit for the slope by
selecting the required option from the Units drop-down list in the Format dialog box for the
Slope parameter. You can select options such as 1 : Ratio, Ratio : 1, Ratio : 12, Ratio : 10,
Rise / 127, Rise / 1’- 07, Rise / 1000 mm, Degrees, or Percentage for the slope measurement
from the Units drop-down list to specify the unit for the slope measurement. By default, the
Decimal degrees option is selected in this drop-down list as the unit system while installing
Revit. The settings for rounding increment for the slope unit can be made from their respective
drop-down list and edit box.
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Setting the Currency Units

In Revit, you can set the unit for the currency as well. To do so, click on the corresponding field
for the Currency parameter in the Project Units dialog box; the Format dialog box will be
displayed. In this dialog box, select appropriate currency symbols and rounding values from
the Unit symbol and Rounding drop-down lists, respectively.

Setting the Mass Density Units

In Revit, you can set the unit for mass density. To do so, click on the corresponding field for the
Mass Density parameter in the Format column in the Project Units dialog box; the Format
dialog box will be displayed. In this dialog box, you can specify the desired unit by selecting it
from the Units drop-down list. The Units drop-down list contains options such as Kilograms
per cubic meter and Pounds mass per cubic foot for mass density measurement. By default,
the Pound per cubic foot option is selected in this drop-down list for the Imperial unit system
and Kilograms per cubic meter option is selected for the Metric unit system. The settings for
the parameters of the rounding, rounding increment, and units symbol can be set by selecting
the required option from the respective drop-down lists.

Setting the Time Units

To specity the unit for time, click in the Format column corresponding to the Time parameter;
the Format dialog box will be displayed. In this dialog box, you can select the desired unit
of time from the Units drop-down list. This drop-down list contains various options such as
Milliseconds, Seconds, Minutes, and Hours.

Setting the Speed Units

'To specify the unit for speed, click in the Format column corresponding to the Speed parameter;
the Format dialog box will be displayed. In this dialog box, you can select the desired unit of
speed from the Units drop-down list. This drop-down list contains various options such as Feet
per minute, Meters per second, Feet per second, Kilometers per hour, and Miles per hour.

/ Note

@ You can format only the display of units on the screen or for printout using the Project Units
dialog box. The actual values for these units in the project may be different. For example, if you
set the wall length rounding to the neavest value 1°, the wall may show this rounded value, but
the actual length of the wall might be in fractional feet. Stmilarly, for Metric, if you set the wall
length rounding to the nearest value 10, the wall may show this rounded value, but the actual
length of the wall might be different.

Structural Unit Type

Structural units include the settings such as Force, Moment, Stress, Unit Weight, and so on. In
Revit, you can set the structural units in the Project Units dialog box. To do so, invoke the Project
Units dialog box and then select the Structural option from the Discipline drop-down list.
Figure 2-5 displays the Project Units dialog box with the Structural option selected in the
Discipline drop-down list. Some of the structural units are discussed next.
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Project Units
Discipline: Structural
Units Format

Acceleration 1234.6 ft/s*
Area Force 1234.5679 ksf
Area Spring Coefficient 1234.6 kip/ft*
Bar Diameter 1234.57"
Crack Width 1234.57"
Displacernent/Deflection 1234.57"
Energy 1234.6 |b-ft
Force 1234.57 kip
Frequency 12346 Hz
Line Spring Coefficient 1234.6 kip/ft*
Linear Force 1234568 kip/ft
Linear Moment 123457 kip-ft/ft
Mass 1234.57 Ibm
Mass per Unit Area 123457 Ib/ft*

Decimal symbol/digit arouping:
123,456,739.00 w

Cance e

Figure 2-5 The Project Units dialog box with
the Structural option selected from the Discipline
drop-down list

Setting the Unit for Force

To specify the unit for the concentrated forces that act on the structural model, click on the
field corresponding to the Force parameter in the Format column; the Format dialog box will
be displayed. In this dialog box, specify a unit by selecting the required option from the Units
drop-down list. The Units drop-down list contains the options such as Newtons, Dekanewtons,
Kilonewtons, Meganewtons, Kips, Kilograms force, Pounds force, and Tonnes force. For the
Imperial unit system, Kips is the default option selected in the drop-down list. For the Metric

unit system, Kilonewtons is the default option selected. The settings for rounding increment
and unit symbol for the force units can be made from their respective drop-down list.

Setting the Unit for Linear Force

The linear force implies a uniformly distributed load that you can apply to any structural member.
To specify unit for the linear force, click on the field corresponding to the Linear Force parameter
in the Format column of the Project Units dialog box; the Format dialog box will be displayed.
In this dialog box, specify the desired unit for the linear force by selecting an option from the
Units drop-down list. The Units drop-down list contains options such as Newtons per meter,
Dekanewtons per meter, Kilonewtons per meter, Meganewtons per meter, Kips per foot,
Kilograms force per meter, Pounds force per foot, and Tonnes force per meter. The default
unit selected for the Imperial unit system in is Kips per foot. The default unit selected for the
Metric unit system in the drop-down list is Kilonewtons per meter.
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Tip

O While selecting a rounding value from the Rounding drop-down list in the Format dialog
box, you should consider the extent of detailing that may be required for the project, and then
select it. For projects that require too much detailing, a lower rounding value may be set. This
parameter, however, can be modified at any time during the project development.

Setting the Unit for Area Force

Area forces denote the pressure forces that you can apply to any structural element (beams,
columns, slabs, and so on). To specify unit for the area force, click on the field corresponding
to the Area Force parameter in the Format column of the Project Units dialog box; the Format
dialog box will be displayed. In this dialog box, specify the desired unit for the area force by
selecting an option from the Units drop-down list. In the Units drop-down list, you can select
various options such as Newtons per square meter, Dekanewtons per square meter, Kilonewtons
per square meter, Meganewtons per square meter, Kips per square foot, Kilograms force per
square meter, and so on. The default unit selected for the Imperial unit system in the drop-down
list is Kips per square foot and for the Metric unit system is Kilonewtons per square meter.

Setting the Unit for Mass per Unit Area

The Mass per Unit Area parameter specifies the density that you can apply on any structural
elements such as rebars, structural steel, and so on. To specify a unit for the mass per unit area,
click on the field corresponding to the Mass per Unit Area parameter in the Format column of
the Project Units dialog box; the Format dialog box will be displayed. In this dialog box, specify
the desired unit for the mass per unit area by selecting an option from the Units drop-down list.
In the Units drop-down list, you can select options such as Kilograms per square meter and
Pounds per square foot. The default unit selected in the Imperial unit system for this parameter
is Pound per square foot and in the Metric unit system is Kilograms per square meter.

Similarly, you can set the units for the other options of different discipline types.

Tip

Q The units specified in the Project Units dialog box will be used as default units for the
elements in the quantiy schedules and take-off sheets. Also, the specified units will be used
while dimensioning objects in a project. You can specify a different unit in the schedules and
dimensions by overriding them based on the need of the project.

STRUCTURAL SETTINGS

Ribbon: Manage > Settings > Structural Settings

In Autodesk Revit, you can specify various structural settings of a project such as settings of the
symbolic representation of structural framing components, settings of various load cases to be
applied to structural model, settings for the analysis to be performed on model, and settings
for providing supports to structural model. You can specify all these settings by using the
Structural Settings dialog box. The Structural Settings dialog box can be invoked by choosing
the Structural Settings tool from the Settings panel of the Manage tab, as shown in Figure 2-6.
This dialog box contains five tabs, namely Symbolic Representation Settings, Load Cases,
Load Combinations, Analytical Model Settings, and Boundary Conditions Settings. In this
dialog box, the Symbolic Representation Settings tab is chosen by default, refer to Figure 2-7.
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Figure 2-6 Choosing the Structural Settings tool

Structural Settings

Symbolic Cutback Distance

Brace:

Beam/Truss:

Brace Symbols
Plan representation:
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Figure 2-7 The Symbolic Representation Settings tab chosen in the
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The settings that you specify in the tabs of the Structural Settings dialog box pertain to the

appearance of the structural members. In the Structural Settings dialog box, you can also
specify the load cases, boundary conditions, and the settings for the analytical model. In this
chapter, you will learn about various options in the Symbolic Representation Settings tab. This

output.

Symbolic Representation Settings Tab

will help you adjust the symbolic representation of various structural elements for documentation

Whenever you invoke the Structural Settings dialog box, the Symbolic Representation Settings

tab is chosen by default, refer to Figure 2-7. The options in this tab control the display and
symbology of different structural conditions in plans, sections, and schedules of steel shapes.
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These options determine how certain elements of an object will display or allow you to use
a symbol of your choice in different conditions. In this tab, there are three areas: Symbolic
Cutback Distance, Brace Symbols, and Connection Symbols. The options in these areas are
discussed next.

Symbolic Cutback Distance Area

The Symbolic Cutback Distance area, refer to Figure 2-7, contains three edit boxes: Brace,
Beam/Truss, and Column. The values in these edit boxes control the cutback distances of the
structural symbolic lines that represent beams, columns, and braces at a coarse detailed level of
a structural project. These values are global settings that affect all beams, trusses, braces, and
steel columns in a project.

In the Symbolic Cutback Distance area, you can enter a numeric value in the Brace edit box to
control the symbolic cutback distance between a structural steel beam or column and a structural
steel brace at a coarse detail level. In the Imperial unit system, the default value in this edit box
is 3/32” whereas in Metric unit system, the default value in the edit box is 2.5000 mm. Figure 2-8
shows the symbolic cutback distance between a brace and a column at a coarse detail level.

Symbolic cuthack
distance between a
brace and a column

Figure 2-8 The symbolic cutback distance between a
column and brace

In the Beam/Truss edit box of the Symbolic Cutback Distance area, you can enter any numeric
value to control the symbolic cutback distance between beams and columns, or between beams,
trusses, and columns. In the Imperial unit system, the default value in this edit box is 3/32”
whereas in Metric unit system, the default value in the edit box is 2.5000mm. Figure 2-9 shows
the symbolic cutback distance between two beams and a column.

Symbolic cutback distance between beams and column

Figure 2-9 The symbolic cutback distance between beams
and column at coarse detail level
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The value in the Column edit box is used to increase or decrease the gap between the symbolic
representations of joined columns in an elevation view. This gap will be visible in a coarse detail
elevation view only if the Top Connection Symbol instance parameter of the bottom column is
set to a value other than None. The default value in the Column edit box is 1/16” for Imperial
unit system and in Metric system, the default value is 1.5875 mm. Figure 2-10 shows the symbolic
cutback distance between columns in an elevation view.

Symbolic cutback distance

between columns in an \1
elevation view — — — i— —

Figure 2-10 The symbolic cutback distance between columns in an elevation view at
a coarse detail level

The Brace Symbols Area

The settings in the Brace Symbols area are used to control the symbolic display of bracing and
kicker bracings that exist in a project. Figure 2-11 shows the settings in the Brace Symbols area
in the Symbolic Representation Settings tab of the Structural Settings dialog box. The Plan
representation drop-down list in this area contains two options: Parallel Line and Line with
Angle. The Parallel Line option is selected by default. As a result, the symbolic representation of
braces in a plan view is displayed with an offset and a line parallel to the actual brace. You can
control the offset distance of this parallel line by entering a suitable value in the Parallel line
offset edit box.

Brace Symbals

Plan representation:

[Parallel Line -

Parallel line offset:

332"

Show brace above
Symbol:

[Connecﬁon-ﬂrace-Parallel - ]

Show brace below
Symbol:

[Connecﬁcn—Erace—Parallel - ]

Kicker brace symbol:

[Connection—Erace—lGdcer hd ]

Figure 2-11 Settings in the Brace Symbols area
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In the Imperial unit system, 3/32” is set as the default value in the Parallel line offset
edit box and in the Metric unit system, default value is 2.3813 mm. Figure 2-12 shows the
symbolic representation of a brace in a plan view with default offset distance. On selecting the Line
with Angle option from the Plan representation drop-down list, the symbolic representations
of braces in a plan view are displayed with an angled line. The angled line originates from the
point of intersection of a brace and level line, if they intersect, or from the closest point to the
level line on the brace. The angled line goes upward from the point of origin for the portion
of the brace which is above the level or it goes downward for the portion of the brace which is
below the level. Figure 2-13 shows a bracing symbol as an angled line.

W12X26
I I

The brace symbol represented as a parallel line in
a plan view

Figure 2-12 The symbolic representation of a brace in a plan view

W12X26

=

Figure 2-13 The symbolic representation of a brace as an angled line

The bracing symbaol as an angled line ———¢

The Show brace above check box in the Brace Symbols area is selected by default. As a result,
the brace symbols representing the braces placed above the current view are displayed. When
you select the Show brace above check box, the Symbol drop-down list below the check box
gets activated. From this drop-down list, you can select an option depending upon the option
selected from the Plan representation drop-down list. You can select the Connection-Brace
-Parallel option from the Symbol drop-down list, if the Parallel Line option is selected in the
Plan representation drop-down list. Similarly, if the Line with Angle option is selected in the
Plan representation drop-down list, you can select the Connection-Brace-Angle from the
Symbol drop-down list. On clearing the Show brace above check box, the brace option placed
above the current view will not be displayed.

Similar to the Show brace above check box, the Show brace below check box is selected by
default. As a result, the brace symbols representing the braces placed below the current view are
displayed. The Symbol drop-down list below the Show brace below check box becomes active
when the Show brace below check box is selected. The options in the Symbol drop-down list
located below the Show brace below check box are similar to those of the Symbol check box
located below the Show brace above check box.

In the Kicker brace symbol drop-down list, the Connection-Brace-Kicker option is selected
by default. As a result, the symbolic representation of a kicker brace will be a connection-brace
in a plan view.
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Note
A normal bracing can be converted into a kicker bracing if the Structural Usage instance
parameter in the Properties palette of the bracing is set to Kicker Bracing, refer to Figure 2-14.

Structural Framing (Kicker Bracing) (1) VI Edit Type
Structural F PN
Start Connection Mane
End Connection Mane |§|
Cut Length 13" 05/128" [
Structural Usage Kicker Bracing
Start Attachment Level Ref... | Level L
Start Attachment Elevation 10" 0"
End Attachment Level Refe...: Level L il

Figure 2-14 Partial view of the Properties palette displaying the
Structural Usage parameter set to Kicker Bracing

Connection Symbols Area

The options in the Connection Symbols area, as shown in Figure 2-15, can be used to control
the symbolic display of moment and shear connections for beams, braces, and columns that
exist throughout the project. To select the type of framing member for which you want to
modify the symbolic display for moment and shear connections, click on the Display Symbols
drop-down list and then select any of the three options: Beams and Braces, Column Base, and
Column Top. In the Display Symbols drop-down list, the Beams and Braces option is selected
by default. As a result, the settings for this option will be displayed in a table located below the
Display Symbols drop-down list, refer to Figure 2-15. In this table, you will notice two columns:
Connection Type and Annotation Symbol. In the Connection Type column, two parameters are
displayed: Moment Frame and Cantilever Moment.

Connection Symbols

Display Symbols

Beams and Braces w
Connection Type: Annotation Symbol:
Moment Frame Connection-Moment-Fill
Cantilever Moment Connection-Moment-No
“Ij rD ’lcj Load...

Figure 2-15 The options in the
Connection Symbols area
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The parameters displayed in the Connection Type column may vary depending on the option selected
from the Display Symbols drop-down list. The values for these parameters are displayed in their
corresponding fields in the Annotation Symbol column. To specify the annotation symbol for a beam
or brace of Moment Frame parameter, click on the Annotation Symbol column corresponding to the
Moment Frame parameter and select any of the three options: None, Connection-Moment-Filled, and
Connection-Moment-Not Filled. Similarly, you can specify an option for Cantilever Moment parameter.
To add a connection type parameter (for beams and braces) in the table, choose the Add a connection
type button (first button from the left) displayed below the table, refer to Figure 2-15. On doing so,
the New Connection Type dialog box will be displayed. In the Connection Type edit box of the

New Connection Type dialog box, enter a name for the new connection type. Next, click in the Annotation
Symbol drop-down list and select an option to assign an annotation symbol for the connection type.
Optionally, in the New Connection Type dialog box, you can choose the Load Symbol button to load
a symbol (with file format .rfa or .adsk) for the new connection type. Now, choose the OK button; the
new connection type will be added as parameter in the table. Next, rename, delete, and create a duplicate
for the connection type displayed in the table.

In the Connection Symbols area, you can specify the base plate symbol for the column. To do so, select
the Column Base option from the Display Symbols drop-down list and specify a symbol for the base plate
from the table displayed below the Display Symbols drop-down list. Similarly, to assign a symbol to the
base plate of a column base, you can specify symbols for shear column connection and moment column
connection by selecting the Column Top option from the Display Symbols drop-down list. Figure 2-16
shows a moment connection and cantilever connection symbols for a steel member.

kI'uioment connection symbol Cantilever connection symbol __/

Figure 2-16 The moment connection and cantilever connection symbols

CONNECTION SETTINGS
Ribbon: Manage > Settings > Structural Settings drop-down > Connection Settings

In Autodesk Revit, you can specify various connection settings for structural connections such
as the Beam end to end, Column - Beam, General bracings, and so on. You can load different
sets of connection in the project by using the Structural Connection Settings dialog box. The
Structural Connection Settings dialog box can be invoked by choosing the Connection Settings
tool from the Settings panel of the Manage tab, as shown in Figure 2-17.

REEHOG-0-7- @ 2-F90A -5 0.+

File Architecture  Structure  Steel  Precast  Systens  Insert  Annotate  Analyze  Massing 8 Site

V| @ e o :

B[ _
Modify| Materials f‘li = u:ﬂ' Structura\ Settings [+ Design cr
5 R~ Options Main Madel - st
Select Settin % Connertion Settings |[Location Design Options Ge

Properties Connection Settings

Opens the Structural Connections Settings dialog in which you
—— can load and unload add-in connections inte Revit. If no add-

Figure 2-17 Choosing the Connection Settings tool
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This dialog box contains two tabs, namely Connections and Parameters. In this dialog box, the
Connections tab is chosen by default, as shown in Figure 2-18.

Structural Connection Settings x
Connections Parameters

Connection Group:

All Connections v

Available Connections: Loaded Connections:

E]EApex haunch ~
dah Base plate
MEase plate cut

E Base plate with traverse, bolted

E Base plate with traverse, welded

E Beam seat T

@Emding plates

EUIting on gauge lines

Add >
;ﬁlgEulting on gauge lines, 2 profiles

|24 Bracing 1 splice angle - additional object <— Remave

@Eracing 1 splice angle double

All None

Figure 2-18 The Structural Connection Settings dialog box

In the Connections tab of the Structural Connection Settings dialog box, the All Connections
option is selected by default in the Connection Group drop-down list. In the Available
Connections area, some of the possible connections between different structural members are
displayed. To load any of the connection types in the project, select the desired connection type
from the Available Connection area and choose the Add button; the selected type of connection
is added to the Loaded Connections area. To load more than one connection type in the project
from the Available Connections area, select desired connections while holding the Ctrl key and
choose the Add button.

You can select different types of connection groups from the Connection Group drop-down
list. The connection groups available in the Available Connections area depends on the type of
connection selected in the Connection Group drop-down list. Some of the Connection Groups
available in this drop-down list are Beam end to end, Column-Beam, General bracings, and
SO on.
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Once connections are added in the Loaded Connections area, choose the OK button, the Structural
Connection Settings dialog box is closed and the type of connections is loaded in the project.

Now, to set a connection between the structural members, invoke the Connection tool from
the Connection panel of the Structure tab. Select the type of connection from the Type
Selector drop-down list in the Properties panel and select the structural member between which
the connection is to be created. The connection loaded from the Type Selector drop-down list
is displayed between the member in the 3D view. If the connection type is not displayed in the
3D view, choose the Visibility/Graphics option from the Graphics panel of the View tab; the
Visibility/Graphic Overrides for <View> will be displayed. Select all the options available in
the Structural Connections head from the Visibility column of the Model Categories tab in
the displayed dialog box, as shown in Figure 2-19.

Visibility/Graphic Overrides for Elevation: North *

Model Categories  Annotation Categories  Analytical Model Categories  Imported Categories  Filters

Show model categories in this view If a category is unchedked, it will not be visible,
Eilter list:
N Projection/Surface Cut Detail -
Visibility . . Halftone Level
Lines Patterns Transparency Lines | Patterns
Stairs [} By View
Structural Area Reinf.., O By View
..M Structural Beam Syst... O
-l Structural Columns [m]
:.. ® Structural ionnecti... Qverride., Override... Override... Override... [ |

<Hiddén Lines>
Anchors

Bolts

Holes
Muodifiers
Others

Plates

Profiles

Reference
Shear Studs

1 R ® EEE

Override Host Layers
[ cut Line Styles Edt...

=

Mone Invert Expand All

Cateqgories that are not overridden are drawn 8
according to Object Style settings. Object Styles...

Concsl | [ 2oy || e

Figure 2-19 The check box selected from the Structural
Connection head

SNAPS TOOL
Ribbon: Manage > Settings > Snhaps

The Snaps tool is one of the important tools used for creating and editing elements in a structural
model. This tool is used to make the cursor snap or jump depending on the preset increments or specific
object properties of elements such as endpoint, midpoint, and so on. Invoke the Snaps tool from the
Settings panel of the Manage tab; the Snaps dialog box will be displayed, as shown in Figure 2-20. This
dialog box has three areas, Dimension Snaps, Object Snaps, and Temporary Overrides. These areas
are discussed next.
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Note
The settings specified in this dialog box will be applied to all the projects opened in the session
and will not be saved.

Snaps x

[ snaps off {s0)
Dimension Snaps

Snaps adjust as views are zoomed.
The largest value that represents less than 2mm on screen is used.

[ Length dimension snap increments
[#;0 60 150 0y |

[l angular dimension snap increments

[30.00°; 45.00% ; 15.00°; 5.00%; 1.00%; |

Object Snaps

[]Endpoints (SE) [/ Intersections D

Midpoints (sM) [ centers (sC)

Nearest (sM) [ Perpendicular (sP)

A work Plane Grid (W) [ Tangents (sT)

[lquadrants (5Q) [Aroints (5X)
Chedk All Check None

[]5nap to Remote Objects (R} [5nap to Point Clouds PC)

Temporary Overrides

While using an interactive tool, keyboard shortouts {(shown in parentheses) can be
used to spedify a snap type for a single pick.

Object snaps Use shortcuts listed above
Close (52)

Turn Override Off (s5)

Cyde through snaps (TAB)

Force horizontal and vertical (SHIFT)

Restore Defaults

Cancel Help
Figure 2-20 The Snaps dialog box

Tip

The Snaps tool is used frequently not only while creating various building elements but also
while editing and placing them. Besides making the modeling simpler; by using this feature
efficiently, you can also improve the performance and accuracy of your project.

~

Dimension Snaps Area

In the Dimension Snaps area, you can set the length and angle dimension snap increments for
placing various elements and components in a project. The dimension snap determines the
increment by which the cursor will jump/snap along with length or angular dimension while
placing elements and components in a project.

The Length dimension snap increments check box is selected by default. As a result, you can
set the snap increment for the length dimension. On selecting the Length dimension snap
increments check box, you can enter suitable value(s) in the edit box to set the snap value for
length. The default values in this editbox are: 4°; 0’ 6”;0" 17; 0’ 0 1/4”, if the English-Imperial
template is selected. On selecting the English-Metric template, the default values in this edit
box are: 1000 ; 100 ; 20 ; 5. Note that every incremental value is separated by a semicolon (;).
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You can also set increments by typing the values that are separated by a semicolon. For example,
to create an interior layout plan in which the length of the partitions is in 5’ (1524mm) modules,
counter top width is 2” (610mm), and thickness of partitions is 4” (100mm), you can enter the
values for the dimension snaps as 5’; 2’;4” (English-Imperial) and 1524; 610; 100 (English-
Metric). This will enable the cursor to move in these increments and help to create the layout with
relative ease. Similarly, you can set the angular dimension snap increments. However, ensure that
the Angular dimension snap increments check box is selected and then enter suitable value(s)
in the edit box below it. This parameter is quite useful for the projects that have radial geometry.
To restore the default setting, choose the Restore Defaults button from the Snaps dialog box.

Note

The reason for specifying multiple length and angle snap increment values in the edit boxes is
that the priovity of increments may change on changing the zoom level of the drawing. Therefore,
when you zoom in the drawing, Revit will use smaller increment values, whereas on zooming out,
the larger increment values will be used.

Object Snaps Area

Object Snaps refer to the cursor’s ability to snap to geometric points on an element such as its
endpoint, midpoint, perpendicular, and so on. In the Object Snaps area of the Snaps dialog box,
you can use various options to snap points of elements or objects in a project. The advantage
of using these options is that you do not need to specify the exact point in a drawing. When
object snaps are enabled, the suitable object snap is displayed as the cursor is moved close to
an element. For example, it is virtually impossible to pick the exact endpoint to start a wall from
the endpoint of an existing wall. But when you enable the endpoint object snap, the cursor
automatically jumps or snaps to the endpoint of this wall. This helps to start the new wall from the
endpoint. This, besides making the drawing accurate, later helps add dimensions to the project.

Tip

O The Dimension Snaps parameter should be set based on the scale and the amount of detailing
required for the project. You may set smaller increments for working on a detailed or small
portion of a building.

Note
The object snaps tool works only with the objects that are visible on the screen. A tooltip, with the
same name as the object snap is also displayed when you bring the cursor close to a snap point.

In a structural model, you can use various Object Snaps modes such as Endpoints, Midpoints,
Nearest, Work Plane Grid, Quadrants, Intersections, Centers, Perpendicular, Tangents,
Points, Snap to Point Clouds, and Snap to Remote Objects.

The name of each object snap option resembles its usage in the project. For example, the Work
Plane Grid snap option helps you snap the intersection points of grid lines in a work plane grid
that is displayed for the current work plane.

Each object snap mode is represented by a geometrical shaped marker to identify it from other
object snaps. For example, the endpoint object snap is represented by a square, midpoint by
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a triangle, nearest by a cross, and so on. To use an object snap mode, move the cursor on the
object. As you move it close to the snap point, a marker appears. To select the appropriate snap
point, click when the corresponding marker or tooltip is displayed.

In Revit, all enabled object snaps work simultaneously. You can turn off all snap options, including
dimension snaps and object snaps by selecting the Snaps Off check box located at the top of
the Snaps dialog box. Alternatively, you can type SO on the keyboard to turn them off and on
while using a tool. The Check All and Check None buttons are used to select or clear all check
boxes (except the Snap to Remote Objects and Snap to point Clouds) in the Object Snaps area.

Temporary Overrides Area

The options in the Temporary Overrides area provide you with an alternative of overriding
snaps setting for a single use only. For example, if you have not selected the Endpoints check
box in the Snaps dialog box and you want to use this option while working with a tool, you do
not need to open the Snaps dialog box to select this option. Instead, you can type the shortcut,
SE in this case, to temporarily activate the endpoint object snap. Once you have used this object
snap option, snapping to the endpoint is automatically turned off.

Using overrides, you can toggle between various object snap options available at the same
location. To do so, press the TAB key while snapping the points in the drawing. You can also
use other overrides like pressing the SHIFT key to create elements vertically or horizontally.
This restricts the movement of the cursor in the orthogonal directions only. Once you release
the SHIFT key, the cursor resumes its movement in all directions. You can select the Snaps Off
check box to disable all types of snapping.

OPTIONS DIALOG BOX

%
In Autodesk Revit, you can configure global settings by using the Options dialog box. %vt
This dialog box can be invoked by choosing the Options button from the File menu. The
Options dialog box, as shown in Figure 2-21, contains ten tabs: General, Graphics, Hardware,
File Locations, Rendering, Check Spelling, SteeringWheels, ViewCube, User Interface, and
Macros. These tabs are discussed next.

General Tab
The General tab is chosen by default and contains five areas: Notifications, Username, Journal
file cleanup, Worksharing update frequency, and View options. These areas are discussed next.

Notifications Area

Revit provides an option for setting reminders to save a work at regular intervals. To do so, select
the desired option from the Save reminder interval drop-down list in the Notifications area.
By default, 30 minutes is selected in this drop-down list. If you do not want a reminder to save
your work in the project, select the No reminders option from this drop-down list. Similarly,
you can select a value in the Synchronize with Central reminder interval drop-down list.
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Options *
User Interface Save reminder interval: | 30 minutes i
Graphics Synchronize with Central reminder interval: | 30 minutes ~
Hardware

Username

File Locations
shamtickon525@gmail. com

Rendering ‘fou are currently signed in. Your Autodesk ID is used as the username. If you

Check Spelling need to change your username, you will need to sign out.

SteeringWheels

ViewCube Journal file deanup

Macras When number of journals exceeds: | 10 =
then

Delete journals older than (days): | 10 =

Worksharing update frequency

Less Frequent More Frequent

Every 5 seconds

View options

Default view disdpline: | Coordination ~

Cancel Help
Figure 2-21 Setting the file options using the Options dialog box

Username Area

In Autodesk Revit, if you are not signed in as a user of Autodesk account, then the username
will not be displayed. To enter a name in the Username area, you need to sign in to Autodesk
360. When you sign in, your Autodesk ID will be used as a username.

Note
If you are not logged into an Autodesk account, system username will be taken as the default
username.

Journal File Cleanup Area

Journal files are the text files that are used to resolve the technical problems which occur during
the Revit session. These files record every step during the session. Whenever you encounter a
technical problem with the software, you can run this file to detect the problem or recover the
lost files or to know the steps that may have caused the problem. In Autodesk Revit, these
files are saved at the following default location: C:|Users\<Username>\AppData\LocallAutodesk)
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Revit\Autodesk Revit 2022\Journals tor Windows 10, Windows 7 or Window Vista users and C:|
Documents and Settings\< Username>\Local Settings\Application for Windows XP users. These files
are saved each time you close the Revit session. Therefore, the number of these files keeps on
increasing until you remove these files from their location. However to remove these files while
retaining some of them, you can use the Journal file cleanup area in the General tab of the
Options dialog box. This area contains two spinners: When number of journal exceeds and
Delete journals older than (days). You can set the required values in these spinners to retain
the recently created files. The default value in both the edit boxes is 10. If you want to delete
journal files if their number exceeds 15 and if they were created before 30 days, then in such a
situation, set the value in the When number of journals exceeds spinner to 15 and the value
in the Delete journals older than (days) spinner to 30.

Worksharing Update Frequency Area

In this area, you can set the update frequency that indicates the time interval for updating the
project in a worksharing environment. To set the limits for worksharing, you can set the slider
between the Less Frequent and More Frequent limits.

View Options Area

In the View options area, you can specify the default view discipline to be used in the Revit
project. To do so, select an option from the Default view discipline drop-down list in this area.
In this drop-down list, the Coordination option is selected by default.

User Interface Tab

The User Interface tab contains four areas: Configure, Ribbon tab switching behavior, View
Switching, and Visual experience. In the Configure area, you can use different options such as
Keyboard Shortcuts, Double-click Options, and Tooltip assistance to change the appearance
and operational settings. In the Tools and analyses box of the Configure area you can use various
options to customize the display of tabs and tools for your Revit Interface. This will help you to
customize the display of Revit tools as per the project requirement. For example, on clearing the
Architecture tab and tools check box, your Revit interface will not display the Architecture tab.

In the Configure area, if you choose the Customize button corresponding to the Keyboard
Shortcuts in the Configure area, the Keyboard Shortcuts dialog box will be displayed. In this
dialog box, various commands with their respective shortcut keys are displayed. You can use the
Assign and Remove buttons to add and remove the shortcut keys.

If you choose the Customize button corresponding to the Double-click Options parameter; the
Customize Double-click Settings dialog box will be displayed. In this dialog box, you can specify
the double-click action response for an element. To do so, select the option in the Double-click
Action coloumn corresponding to desired element displayed under the Element Type column;
a drop-down list will be displayed. Select an option from the drop-down list for the required
double-clicking response for the element; double-click response of the element will change to
the newly chosen option.

In the Configure area, you can select an option from the Tooltip assistance drop-down list to
set the required level of assistance that a tool tip will display when a cursor is placed over a tool
or an element in the project view. From the drop-down list, you can select any of the following
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options: Normal, None, Minimal, and High. By default, the Normal option is selected in the
Tooltip assistance drop-down list.

In the Ribbon tab switching behavior area, you can specify the tab to be displayed once you
clear a selection or exit a tool. In this area, the Project Environment drop-down list contains two
options: Stay on the Modify tab and Return to the previous tab. Select the Stay on the Modify
tab option to display the options in the Modify tab after exiting a tool or clearing a selection.
Alternatively, you can select the Return to the previous tab option to display the last used tab
after exiting a tool or clearing a selection. Similarly, you can use the settings in the Family Editor
heading to specify the display behavior of the family editor mode. In the Ribbon tab switching
behavior area, the Display the contextual tab on selection check box is selected by default. As
a result, the contextual tab is displayed once you select a tool from the Revit interface.

In the View Switching area of the dialog box, you can customize the use of Ctrl+Shift+Tab
command while you are working in a project. You can use the Ctrl+(Shift)_Tab drop-down to
select an option to customize the behavior of the switching application.

To change the theme of Revit interface, choose the desired option from the Active theme
drop-down list of the Visual experience area. There are two themes available in the Active
theme drop down list: Light and Dark. Light theme is selected by default. To accelerate the
graphical speed of any operation in software, select the Use hardware graphics acceleration if
available check box from the Visual experience area in the User Interface tab.

Graphics Tab

You can use this tab to assign colors to selections, highlights, and alerts, and to enable
anti-aliasing for 3D views. In the View navigation performance area, the Allow navigation during
redraw check box is selected by default. The selection of the check box allows you to navigate
the model in a 2D view or a 3D view, and also pan, zoom and orbit while sketching the drawing.
On clearing the check box, you will not be able to perform any of the above actions before the
completion of drawing. In this area, the Simplify display during view navigation check box
is cleared by default. If you select this check box, it will suspend various graphic effects and
details such as fill and line, shadows, hidden lines, underlays, etc during camera manipulation.
In the Graphics mode area, you can select the Smooth line with anti-aliasing check box to
improve the quality of lines in 3D views. In the Colors area of the Graphics tab, choose the
button corresponding to the Background parameter to change the color of the background.
The Selection parameter refers to a color that an element acquires when it is selected. The
default color is RGB 000-059-189. To use any other color, click the button on the right of the
Selection parameter and select the desired color from the Color dialog box. The Pre-selection
parameter is used to specify the color of the highlighted elements. To use any other color, click
the button on the right of the Selection parameter to display the Color dialog box and then
select the desired color from this dialog box. Revit uses the Alert button to highlight elements
when an error occurs. In the Colors area, you can select the Semi-transparent check box to
make the selected elements semi-transparent. Semi-transparency of a selected element allows
you to view the elements behind it. In the Temporary dimension text appearance area, you
can select an option from the Size drop-down list to specify the size of temporary dimension
text. You can also set the background of the temporary dimensions text. To do so, select the

Opaque or Transparent option from the Background drop-down list. Transparent is selected
by default.
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Hardware Tab

The options in the Hardware tab enables you to view information related to hardware setup and
change related information for better navigation and rendering view. In the Hardware setup
area of this tab, the Use hardware acceleration check box is selected by default. As a result, the
hardware accelerators are enabled. Hardware accelerators help display the larger models faster
on refreshing the views. In addition, the hardware accelerators help you speed up the process
of switching between the windows of views.

File Locations Tab

By using the File Locations tab, you can set the path for various files and directories that are
accessed frequently, refer to Figure 2-22. The path for these files is set while installing Revit.
However, you can modify the location of a file by choosing the corresponding Browse button
and specify a new location. You can also change the default template file location, in case, you
wish to use a custom made template file for your projects. In Revit, the default path to save or
open a project can be specified in the Default path for user files edit box. You can also specify
the default path for family template files and for the point clouds by using the corresponding
Browse button.

Options X
General Project templates: The templates display in a list when you create a new project.
User Interface

+E Name Path o)
Graphics I Construction Te...  C:\ProgramData\Autodesk\RVT 20224 Tem...
Hardware Architectural Te... C\ProgramData\Autedesk\RVT 2022\ Tem...
Structural Templ... { CA\ProgramDatalAutodesk BVT 20224 Tem...

) ; P p g

Mechanical Tem... i C:\ProgramData\Autodesk\RVT 20224 Tem...
Rendering = |Systems Template C:\ProgramData\Autodesk\RVT 2022 Tem...
_ Electrical Template : C:\ProgramData\Autodesk\RVT 20224 Tem...

Check Spelling Plumbing Templ... :C:\ProgramData\Autedesk\RVT 2022\ Tem... ¢

SteeringWheels
Default path for user files:

| C:\Users\AsUS \Documents | Browse. ..

ViewCube

M
acros Default path for family template files:

| Ct\ProgramData\autodeskiRVT 2022'Family Templates\English | Browse. ..
Root path for point douds:
| C:\Users\ASUS \Documents \PointClouds | Browse...

Systems analysis waorkflows:

+E MName Path
Annual Building En.... C:\Program Files\MREL\OpenStudio CLI For...
£ HVAC Systems Loa... | C:\Program Files\MREL\OpenStudio CLI For...

+

—

Flaces. ..

Figure 2-22 The File Locations tab of the Options dialog box
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In Autodesk Revit 2022, you can add a new template file used for the workflows for system
analysis. To do so, click the Add Value button under the System analysis workflows: area and
specify the desired path for the new template file in the Browse for System Analysis Workflow
dialog box. To modify the path of the default template file, click on the path given under the Path
column corresponding to the desired workflow; the Browse button will be activated. Now, click
on the Browse button; the Browse for System Analysis Workflow dialog box will be displayed.
In this dialog box, specify the desired path for the template file.

Rendering Tab

Autodesk Revit uses the mental ray rendering engine for its rendering process. The mental ray
has its own library, Render Appearance Library. This library stores information about render
appearances for materials, default RPC contents in the software, and other information relevant
to the rendering process. The Render Appearance Library is a read-only library and is loaded
into the following default location while installing the Revit software: C:\Program Files (x86)|
Common Files | Autodesk Shared | Materials | 2022 |assetlibrary_base.fbm.

In addition to the default Render Appearance Library location, you can also specify paths
for the additional image files defining texture, bump map, and custom color for the render
appearance that you can use in the project. These image files are not present in the software and
therefore, you need to specify their paths to use them. To do so, choose the Add Value button
in the Additional render appearance paths area and specify the required path in the displayed
field or choose the Browse button; the Browse For Folder dialog box will be displayed. In this
dialog box, select the desired path and choose the Open button to add the path in the field.

Check Spelling Tab

Revit provides you with the option to run spell check to find out spelling errors in text and then
rectify them. You can choose the Check Spelling tab from the Options dialog box to display
its options. Figure 2-23 shows various options in the Check Spelling tab. In the Settings list
box of this tab, you can specify various self-explanatory settings by selecting their respective
check boxes. In the Main Dictionary area, you can select the type of dictionary to be used as
main dictionary for the spell check from the Autodesk Revit drop-down list. Apart from the
main dictionary, you can also use additional dictionaries available in this dialog box such as
the personal and building industry dictionaries. This facilitates the use of various personal and
industrial terms in the text. There are many words that are not included in the main dictionary but
are frequently used in the building industry. For example, the abbreviation ‘conc’ for the word
concrete is not available in the main dictionary. The additional building industry dictionary has
many such words and abbreviations that can be used in the text of the project and therefore, it
does not prompt you to check for spelling errors when it finds such terms/words. You can also
add or remove words from your personal and building industry dictionary. To do so, choose
the Edit button next to the required option in the Additional dictionaries area to view the list
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of words and then enter or remove any word from these lists by using the cursor and keyboard.
To run spell check in your drawing, choose the Check Spelling tool from the Text panel of the
Annotate tab; the Spelling dialog box will be displayed, wherein you can rectify spelling errors
in the text by selecting the correct spelling and then choosing the Change button in the dialog
box. Alternatively, you can press the F7 key to display the Check Spelling dialog box.

Options *

General Settings:

D_{gnore words in uppercase (DWG)

User Interface
[ lgnere words with numbers {(ISC9000)

Graphics [tanere capitalized words (Autodesk)
DIgnore words with mixed cases (TrueType)
Hardware Find repeated words

File Locations

Rendering
Check Spelling
3 - Main dictionary
SteeringWheels Autodesk Revit
WiewCube American English w
Macros

Additional dictionaries
Personal dictionary containg words added during spell check:

| C:\ProgramData\Autodesk\RVT 2022\Custom. dic | Edit...

Building industry dictionary
| C:\ProgramData\Autodesk\RVT 2022\RevitENU. dic | Edit...

Cancel Help
Figure 2-23 The Check Spelling tab of the Options dialog box

SteeringWheels Tab

The SteeringWheels tab in the Options dialog box has options to control the visibility,
appearance, and operational tools of different types of SteeringWheels. This tab has seven
different areas, as shown in Figure 2-24. These areas are discussed next.

Text Visibility Area
You can control the display of tool messages, tooltips, and tool cursor of SteeringWheels by using
the options in the Text visibility area of the SteeringWheels tab. You need to select the Show
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tool messages check box to enable the visibility of tool messages in SteeringWheels. To display
tooltips along with SteeringWheels, select the Show tooltips check box in this area. Similarly,

to control the display of the cursor text when a tool is active, select the Show tool cursor text
check box.

Options bt

General Text visibility
Show tool messages (always ON for basic wheels)

User Interf:
ser Interiace [#] Shows tooltips (always ON for basic wheels)

Graphics Show tool cursor text (always OM for basic wheels)
Hardware Big steering wheel appearance
Size: |Mormal ™ Opacity: 50%

File Locations
Mini wheel appearance
Size: |Normal ~ Opacity: 50%

Rendering

Check Spelling
Look tool behavior

SteeringWheels [ J1nvert vertical axis (Pull mouse back to look up)

ViewCube Walk tool

Macros [#]Move parallel to ground plane

Speed Factor:

0.1 I 10.0

Zoom tool

[Jzoom in one increment with each mouse click (always ON for basic wheels)

Orbit tool
Keep scene upright

Restore Defaults Cancel Help

Figure 2-24 The SteeringWheels tab of the Options dialog box

Big Steering Wheel Appearance and Mini Wheel Appearance Areas

The options in these areas are used to set the size and transparency of the SteeringWheels.
To set the size of SteeringWheels, select the required option from the Size drop-down list in
the corresponding areas and set its size to small, normal, or large. Similarly, you can set the
transparency of SteeringWheels by selecting the required option from the Opacity drop-down list.

Look Tool Behavior and Walk Tool Areas

In the Look tool behavior area of the SteeringWheels tab, select the Invert vertical axis check
box to change the vertical axis movement of the view. Selecting this check box enables the view
to move in the same direction as the cursor does in the vertical axis.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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The Speed Factor slider in the Walk tool area is used to change the speed of walk while using
the Walk tool of the SteeringWheels. You can also select the Move parallel to ground plane
check box in the Walk tool area to constrain the angular movement of the walk to ground plane.

Zoom Tool and Orbit Tool Areas
Select the Zoom in one increment with each mouse click check box in the Zoom tool area to
enable the zooming operation with a single click.

In the Orbit tool area, select the Keep scene upright check box to maintain perpendicularity
between the sides of the model and the ground plane while using the Orbit tool.

ViewCube Tab

The ViewCube tab in the Options dialog box is used to edit various settings of the ViewCube. It
has four different areas: ViewCube appearance, When dragging the ViewCube, When clicking
on the ViewCube, and Compass, as shown in Figure 2-25. These areas are discussed next.

Options x
General ViewCube appearance

User Interface Shnw the ViewCube

Graphics Show in:  All 3D Views ~
Hardware On-screen position:  Top Right ~

File Locations ViewCube size: Automatic ~
Rendering Inactive opacity: 50 % ~

Check Spelling When dragging the ViewCube

SteeringWheels [~]snap to closest view

‘When clicking on the ViewCube

Macros
Fit-to-view on view change

Use animated transition when switching views

Keep scene upright

Compass

Show the compass with the ViewCube (current project only)

Restore Defaults Cancal Help
Figure 2-25 The ViewCube tab of the Options dialog box
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ViewCube Appearance Area

This area is used to control the appearance and display of the ViewCube. In this area, the Show
the ViewCube check box is selected by default. As a result, the ViewCube will be visible. If you
clear this check box, the ViewCube will disappear and all options in the ViewCube tab will be
deactivated. In the ViewCube appearance area, you can use various drop-down lists to align,
resize, and change the transparency of the ViewCube.

Select the options from the On-screen position drop-down list to align the ViewCube on the
screen. Similarly, if you want to resize the ViewCube, select the required option from the ViewCube
size drop-down list. You can also set the opacity of the inactive ViewCube by selecting an option
from the Inactive opacity drop-down list.

When Dragging the ViewCube Area
Select the Snap to closest view check box in this area to enable the snap to select the closest
view in the ViewCube.

When Clicking on the ViewCube Area

Select the Fit-to-view on view change check box in the When clicking on the ViewCube
area to fit the view on the screen while changing the viewing direction. In this area, the
Use animated transition when switching views check box is selected by default. As a result, the
animated transition occurs while switching the views. If you clear this check box, the animated
transition will not occur while using the ViewCube. Select the Keep scene upright check box to
keep the sides of ViewCube and the sides of the view perpendicular to the ground plane. Clear
the check box to turn around the model in full 360-degree swing. Clearing this check box can
be useful when you are editing a family.

Compass Area

In this area, the Show the compass with the ViewCube check box is selected by default. As a
result, the compass along with the ViewCube is visible in the drawing. In the ViewCube tab,
you can choose the Restore Defaults button to restore the default settings that were changed
in its different areas.

Macros Tab

Revit provides you with the option to run macros within the projectl and then rectify the problems
occurred. To do so, choose the Macros tab from the Options dialog box; various options will be
displayed in the window, refer to Figure 2-26. The options in the Macros tab can be used to set the
security level for the macros used in the project. There are two options in this area, Application
macro security settings and Document macro security settings, which are discussed next.

Application Macro Security Settings Area

In this area, the Enable application macros radio button is selected by default. As a result, the
application macros in the project are enabled. To disable the application macros, select the
Disable application macros radio button from the Application macro security settings area.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Document Macro Security Settings Area

In this area, the Ask before enabling document macros radio button is selected by default. As
a result, the document macros are disabled but you will be prompted to enable them whenever
you open a project that contains a macro. To enable the document macros, select the Enable
document macros radio button. Similarly, to disable a document macros in the project, select
the Disable document macros radio button in the Document macro security settings area.

Options s

General Application macro security settings

Changes to application macro settings will take effect the next time Revit starts.
User Interface

(@) Enable application macros

Graphics

() Disable application macros
Hardware
File Locations Document macro security settings

Changes to document macro settings will take effect the next time Revit opens a

Rendering document.
Check Spelling (@ Ask before enabling document macros
SteeringWheels (O pisable document macros
ViewCube (C) Enable document macros

Figure 2-26 The Macros tab of the Options dialog box

SAVING A PROJECT %

Before you close or exit a Revit session, it is recommended to save the project file. %&m
You can save a project file in a permanent storage device, such as a hard disk or a
removable storage device like CD or USB. Also, you must save your work at regular intervals to
avoid data loss due to any error in the computer’s hardware or software.

Tip
Q In Revit 2022, you can save the current model in the cloud. 1o do so, choose Save As >
Cloud Model from the Application Menu.
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Using the Save As Tool
Application Menu: Save As > Project

In Revit, you can save your project file at the desired location. To do so, choose the File menu
and then choose Save As > Project; the Save As dialog box will be displayed, refer to Figure 2-27.
Alternatively, you can save the project file by choosing the Save button from the =
Quick Access Toolbar.

R Save As ? x
Save in: | Project v| 4= ! 4 .+ Views
Name - Date modified Type Size
= 06-00-2021 T6:51 Autodesk Revit Pr... 5280 KB |

File name: | EIM_Strcutural v]

Files of type: | Project Files (%rvi) v | optons.. |

e [ e |

Figure 2-27 The Save As dialog box

In the Save As dialog box, the Save in drop-down list displays the current drive and path in
which the project file will be saved. The list box below the Save in drop-down list shows all
folders available in the current directory. The File name edit box is used to specify the name of
the file to be assigned to the project. The Places List area on the left of the Save As dialog box
contains shortcuts for the folders that are frequently used.

You can use different file saving features by choosing the Options button from the Save As dialog
box. On choosing this button, the File Save Options dialog box will be displayed, as shown in
Figure 2-28. Using the Maximum edit box from this dialog box, you can specify the maximum
number of backup files that you need to store for a project. In Autodesk Revit, the non-workshared
projects have three backup files and the workshared projects have twenty backup files by default.
The options in the Worksharing area are inactive for non-workshared projects. You can use the
options in this area to make the current workshared file central compact and select the default
workset. The options in the Thumbnail Preview area enable you to specify the image to be used
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as the preview of the project file. This image is used at the time of opening a project file. You can
specify a view of the model as a preview image by selecting the corresponding option from the
Source drop-down list in the Thumbnail Preview area of the File Save Options dialog box. By
default, the Active view/sheet option is selected in the Source drop-down list of the Thumbnail
Preview area for the preview of a project file. For example, to make Structural Plan: Level 1
as the preview image, select it from the drop-down list. As a result, when you invoke the Open
dialog box and select a file to open, the view displayed in the Preview area will correspond to
the selection that is made from the Source drop-down list in the File Save Options dialog box.

File Save Options *

Maximum Ijl

Worksharing

Make this a Central Model after save

Compact File

Open workset default:

Thumbnail Preview

Source: | Active viewsheet ~

[_]Regenerate if view/sheet is not up-to-date.

Figure 2-28 The File Save Options dialog box

In the File Save Options dialog box, you can select the Regenerate if view/sheet is not up-to-date
check box to see the preview with the latest modifications. On selecting this check box, the
preview image will be updated when you close the project file.

Note
@ Reuvit updates the preview image continuously. Therefore, selecting the Regenerate if view/sheet
=7 is not up-to-date check box can consume considerable resources.

Using the Save Tool

Once a project has been saved using the Save As tool, you do not need to re-enter file parameters
to save it again. To save a project to the hard disk, choose the File menu button and then choose
the Save option from File Menu. If you are saving the project for the first time, the Save As
dialog box will be displayed, even if you invoke the Save tool.

Tip
O By default, the preview of a file is the last active view or sheet at the time it was last saved. You
can set the preview to a particular view using the Options button in the Save As dialog box.

Alternatively, you can save your project by choosing the Save button from the Quick Access
Toolbar. As you save your project file, Revit updates it automatically without prompting you to
re-enter the file name and path.
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CLOSING A STRUCTURAL PROJECT

To close a project, choose the File menu button and then select the Close option. If you have
already saved the latest changes, the project file will be closed. Otherwise, Revit will prompt you
to save the changes through the Save File dialog box. You can save the changes by choosing the
Yes button or discard them by choosing the No button. You can also choose the Cancel button
to return to the interface and continue working on the project file. You can also use the Close
button (X) in the drawing area to close the project.

EXITING A STRUCTURAL PROJECT

To exit a Revit session, choose the Exit Revit button from File menu. Even if the project is open,
you can choose the Exit Revit button to close the file and exit Revit. If the project has not been
saved once, the Save File dialog box will be displayed on choosing the Exit Revit button. In this
dialog box, if you choose the No button, all unsaved changes will be lost. You can also use the
Close button (X) in the main Revit window (in the title bar) to end the Revit session.

OPENING AN EXISTING STRUCTURAL PROJECT

Application Menu: Open > Project
Shortcut Keys: CTRL+0O

In Autodesk Revit, there are several options available to open an existing project. These options
are discussed next.

Opening an Existing Project Using the Open Tool

To open an existing project file, choose Open > Project from File Menu, as shown
in Figure 2-29. Alternatively, you can open the project file by choosing the Open
button from the Quick Access Toolbar or by pressing the CTRL+O keys. On invoking the
Open tool, the Open dialog box will be displayed, as shown in Figure 2-30. Using the Look in
drop-down list in this dialog box, you can access the desired folder and open the desired file.

REecHG -G-8 a-FO0A @-0f

Architecture  Structure  Steel  Precast  Systems  Insert

(})'_j Opens a Revit-compatible file.

D Mew 3 [ Cloud Model

Dpens a Revit cloud madel.

E Open » E Proj

Opensa Revit project.

E Save @ Family

Opens a Revit family,

g Save As 3 @ Revit file

Opens any Revit file type.

[

Figure 2-29 Choosing the Project option from the File menu
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R Open 7 X

Look in: Downloads v| 4= E b 4 .+ Views

. - Preview
A | Mame Date modified Type

This folder is empty.

< >
File name: | v |
Desktop
P ] Files of type: |AJI Supported Files {*.rvt, *.rfa, *.adsk, *.rte) ~ |
Waorksharing
[ Audit Detach from Central Create New Local | Open ||z| | Cancel

Figure 2-30 The Open dialog box

The Preview area of the Open dialog box shows the preview of the selected project file. It helps
you select a particular file by viewing its contents, even if you are not sure about the name of the
file. The window icons such as the Views menu, placed on the right of the Look in drop-down
list, helps you select a project file based on its size, type, or date when it was last saved. On
choosing the Thumbnails option from the Views menu, you can preview the contents of the
project files inside the selected folder in the file list area. In the Open dialog box, you can
browse to important locations from the Places list. The Places list is located on the left side of
the Open dialog box. In this list, you can add or remove folders as per your requirement. To
do so, first close the Open dialog box and then choose the Options button from File menu; the
Options dialog box will be displayed. In this dialog box, choose the File Locations tab and then
the Places button from it; the Places dialog box will be displayed, as shown in Figure 2-31. The
Places dialog box contains two columns: Library Name and Library Path.

Places X
Library MName Library Path
1 [Metic Library C\ProgramData\Autodesk\RVT 2022 Libraries\English'
+E
=
[ o ][ cond || b

Figure 2-31 The Places dialog box
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You can add or remove folders in the libraries list to create a list of frequently accessed folders. The
four buttons on the left side of the Places dialog box can be used to create or delete a library,
or move it up and down in the list. To create a new library, choose the Add Value button, which
is the third button from the top; a new library will be added to the defined path. By default, the
name of the new library in the Library Name section will be New Libraryl. Change the name of
the new library and then click in the Library Path column to display the Browse button. Choose
the Browse button and select the folder to be added in the libraries list by using the Browse For
Folder dialog box. Next, choose the Open button; the new folder will get added to the list. If
required, choose the upward arrow button from the Places dialog box to move the folder up to
the top of the list. Similarly, you can choose the down arrow button to move it down. To delete
a library, select it and choose the Remove Value button. Choose the OK button in the Places
dialog box to exit, and then close the Options dialog box. When you invoke the Open tool next
time, the new folder icon will be displayed in the places list.

Once the file to be opened has been selected, its name will be displayed in the File Name edit
box of the Open dialog box and its preview will be displayed in the Preview area.

. Note
@ If you try opening an already opened file that has been modified in the Revit session, a message
“ box appears, prompting you to close the file first and then reopen it. In case, you open a file that
has been created using an older version of Revit, the Program Upgrade message box s displayed.
This message box informs that the file is being upgraded to the latest file format and that this is
a onetime process. Once the file is opened, choose the Save button from the Application menu to
save 1t to upgraded Autodesk Revit version.

Using the Windows Explorer to Open an Existing Project

Apart from using the Open tool from the Revit interface to open a file, you can also open files
directly from the Windows Explorer by using the methods discussed next. A file can be opened by
double-clicking on its icon in the Windows Explorer. It opens the project file in the latest Revit
session. If Revit is not running, double-click on the file icon to start Revit and then open the file.

Another method of opening a project file is by dragging the project file icon from the Windows
Explorer and dropping it in the drawing window of the Revit interface. You can also select, drag,
and drop more than one file in the drawing window. In this case, Revit prompts you to open
the files in separate windows. Choose the OK button to open all files in the same Revit session.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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TUTORIALS

In this tutorial, you will create two structural projects as tutorials: a commercial project of a
concrete structure and an industrial project of steel and concrete structure. These tutorials will
be created in a sequence according to the topics discussed in the chapter.

Tutorial 1 Commercial Complex

In this tutorial, you will create a revit file for the Commercial Complex project with the following
parameters and project specifications: (Expected time: 15 min)

1. Template file:
For Imperial ~ English-Imperial > Structural Analysis-Default.rte
For Metric English-Metric > Structural Analysis-DefaultMetric.rte

2. Project Units:
For Imperial  Feet and fractional inches, Rounding- To the nearest 1/2”
For Metric Millimeters, Rounding- To the nearest 10

3. Length dimension snap increment:
For Imperial 552°67;0°3”;0°01/2”
For Metric 1500; 70; 705 10

4. File name to be assigned:
For Imperial  ¢02_Commercial-Complex_tutl.rvt
For Metric M_ c02_Commercial-Complex_tutl.rot

The following steps are required to complete this tutorial:
a. Start a Revit session.

b. Open a new project.

c. Use the template file for the project.
For Imperial ~ Structural Analysis-Default.rte.
For Metric Structural Analysis-DefaultMetric.rte

d. Select project units.

e. Set Endpoint, Midpoint, Nearest, Perpendicular, Work Plane Grid, and Intersections
as the object snaps in the Snaps dialog box for both the systems (Imperial & Metric).

f.  Save the project by using the Save tool.
For Imperial  c02_Commercial-Complex_tutl.rot

For Metric M _c02_Commercial-Complex_tutl.rot

g. Close the project by using the Close tool.
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Starting Autodesk Revit 2022
1. Start Autodesk Revit by choosing Start > All Programs > Autodesk > Revit 2022. On
doing so, the Revit interface window is displayed.

Opening a New Project
1. Choose New > Project from menu; the New Project dialog box is displayed.

Selecting the Template File
To select the template file for the project, you need to access the appropriate folder and select
the required template file from it.

1. In the New Project dialog box, choose the Browse button from the Template file area;
the Choose Template dialog box is displayed. This dialog box shows a list of template files
available in the English-Imperial folder if Imperial unit system is selected at the time of
Revit installation. (On selecting Metric unit system, list of metric template is displayed).

2. In the Choose Template dialog box, the template file named Structural Analysis-Default.
rte, as shown in Figure 2-32, is selected as the default template file in the English-Imperial
folder. In English-Metric folder, default template file is Structural Analysis-DefaultMetric.
rte. Choose the Open button to assign the selected template file to the New Project dialog
box.

3. Select the Project radio button (default) to create a project file and then choose the OK
button; the selected template file of selected unit system is loaded. Note that the Project
Browser shows different levels and views that have already been created in the selected
template file.
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S
1.

o

&0

=

R Choose Template ? x

Look in: | English-Imperial vl = E b 4 ._,_ Views =

Preview

MName Date modified .

CommerciaI-Default.rte

Construction-DefauIt.rte

default.rte R .
Electrical-Default.rte
LT_USI_Commercial-Default.ite
LT_USI_Default.rte
LT_USI_Residential-Default.rte
Mechanical-DefauIt.rte
PIumbing-DefauIt.rte

Precast Detailing-Default.rte
Residential-Default.rte
EEStructu ral Analysis-Default.rte
Systerns-Default.rte

File name: | Structural Analysis-Default.rte v|
Files of type: |Ternp|ahe Files (*.rte) v|
| Open | | Cancel

Figure 2-32 The Choose Template dialog box

etting Project Units

To set units for the project, choose the Project Units tool from the Settings panel of the
Manage tab; the Project Units dialog box is displayed.

Make sure that the Common option is selected in the Discipline drop-down list of the
Project Units dialog box. Now, click in the Format column corresponding to the Length
unit; the Format dialog box is displayed.

In this dialog box, select the option by clicking on the Units drop-down list.
For Imperial ~ Feet and fractional inches
For Metric Millimeters

Select the option from the Rounding drop-down list.
For Imperial ~ To the nearest 1/2”
For Metric To the nearest 10

Choose the OK button in the Format dialog box and then in the Project Units dialog box
to close them.

Setting Dimension and Object Snaps
You need to set dimension snaps and object snaps by using the Snaps tool. These settings are
based on the type of the project and the amount of detailing required.
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Choose the Snaps tool from the Settings panel of the Manage tab; the Snaps dialog box is
displayed, as shown in Figure 2-33.

In the Dimension Snaps area of this dialog box, ensure that the Length dimension
snap increments check box is selected.

Now, click in the edit box below the Length dimension snap increments check box and
enter new values as given next.

For Imperial 5’52’ 6”; 0°3%; 0’ 0 1/2”

For Metric 15005 700; 705 10

Figure 2-33 shows the value entered for length snaps increment.
In the Object Snaps area, clear the Quadrants, Centers, Tangents, and Points check boxes

to disable them. Leave rest of the check boxes enabled, refer to Figure 2-33. Choose the OK
button to apply settings and to close the Snaps dialog box.

Snaps X

[ snaps off (50)
Dimension Snaps

Snaps adjust as views are zoomed.
The largest value that represents less than 2mm on screen is used.

[#]Length dimension snap increments
[s:26 ;030012 |

[ Angular dimension snap increments

| 90.00° ; 45.00° ; 15.00° ; 5.00° ; 1.00° ; ‘

Object Snaps

Endpoints (SE) Intersections (5D
Midpoints (sM) []cCenters (sC)
[~ nearest (SN) [~]Perpendicular (5F)
[ work Flane Grid (sw) [|Tangents (sT)
[Jquadrants (5Q) []Points (5X)

Check All Check Mona
Snap to Remote Objects (SR) Snap to Point Clouds (PC)

Temporary Overrides

While using an interactive tool, keyboard shortcuts (shown in parentheses) can be
used to specify a snap type for a single pick.

Object snaps Use shortcuts listed above
Close (52)

Turn Override Off (ss)

Cycle through snaps (TAB)

Force horizontal and vertical (SHIFT)

Restore Defaults

Figure 2-33 The Snaps dialog box
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Saving the Project
The project parameters set in the previous steps are the global settings of the project file. To
save this project file, use the Save As tool.

1.

Choose the Save option from the File menu. As you are saving the project for the first time,
the Save As dialog box is displayed.

In this dialog box, browse to the C drive and then create a folder with the name rst_2022.
Opentherst_2022 folder and then create a sub-folder with the name c02_rst_2022_tut. Next, open
the created folder and save the file with the name c02_Commercial-Complex_tutl.rvt (For Imperial),

refer to Figure 2-34. For Metric, save the file with the name M_c02_Commercial-Complex_tutl.rvt.

Choose the Save button; the Save As dialog box closes and the project file is saved.

R save s ? x

Savein: || cD2.rst 2022 fut v 4= B X B vews ~

Mame Date modified Type Size
This folder is empty.

E Bk 07 Commer ial-Complex_futLrvt v|

Files of type: | Project Files (*.rvt) V| | Options... |

| Save | | Cancel |

Figure 2-34 The Save As dialog box

Closing the Project

1

. Choose the Close option from the File menu in the Ribbon.

Tutorial 2 Industrial Complex

In this tutorial, you will create a new project file for the Industrial Complex project by using the
following parameters and project specifications. (Expected time: 15 min)

1.

Template file:
For Imperial ~ English-Imperial > Structural Analysis-Default.rte
For Metric English-Metric > Structural Analysis-DefaultMetric.rte
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Project Units:
For Imperial ~ Feet and fractional inches, Rounding- To the nearest 1/4”
For Metric Millimeters, Rounding- To the nearest 10

Length dimension snap increment:
For Imperial 10’ 2°6; 1’; 0°3”
For Metric 3000; 760; 300; 70

Object snaps to be set- all available object snaps.
File name to be assigned:

For Imperial  ¢02_Industrial-Complex_tut2.rut
For Metric M_c02_Industrial-Complex_tut2.rot

The following steps are required to complete this tutorial:

h.

Start the Revit session.
Open a new project.

Use the template file.
For Imperial  Structural Analysis-Default.rte
For Metric Structural Analysis-DefaultMetric.rte

Set the project units by using the Project Units dialog box.
For Imperial  Feet and fractional inches
For Metric Millimeters

Set the length dimension snap increment in the Snaps dialog box.
For Imperial 10’ 2°6; 1’; 0°3”
For Metric 3000; 760; 300; 70
Enable all object snaps using the Snaps dialog box.
Save the project by using the Save As tool.
For Imperial  ¢02_Industrial-Complex_tut2.rot
For Metric M_c02_Industrial-Complex_tut2.rot

Close the project by using the Close tool.

Starting Revit and Opening a New Project

1.

Start a new Revit session by double-clicking on the Revit 2022 shortcut icon on the desktop.
The program is loaded and the user interface screen is displayed. If the Revit session is
already running, you can ignore the step and open the project file directly.

Choose New > Project from the File menu; the New Project dialog box is displayed.
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Using the Template File
As given in the project parameters, you need to use the template file for this project. You can
select this template file from the New Project dialog box.

1. In the New Project dialog box, choose the Browse button in the Template file area; the
Choose Template dialog box is displayed. Select the Structural Analysis-Default.rte
template file from the English-Imperial folder or the Structural Analysis-DefaultMetric.
rte template file from the English-Metric folder and then choose the Open button; the
Choose Template dialog box is closed. Make sure that the Project radio button is selected
in the Create new area. Next, choose OK to exit the New Project dialog box; the template
file is loaded for this project.

Setting Project Units

You can set units for various measurement parameters by using the Project Units dialog box.

1. Choose the Project Units tool from the Settings panel of the Manage tab; the Project Units
dialog box is displayed.

2. Click in the Format column corresponding to the Length unit; the Format dialog box is
displayed. In this dialog box, select the option from the Units drop-down list.
For Imperial  Feet and fractional inches
For Metric Millimeters

3. Click on the Rounding drop-down list and select the desired option, as shown in Figure 2-35.
For Imperial ~ To the nearest 1/4”
For Metric To the nearest 10

Format X
Use project settings
Units: Feet and fractional inches ~

Rounding:

To the nearest 1/2" w

To the nearest 1'
To the nearest 6"
To the nearest 1"
To the nearest 1/2"
To the nearest 1/8"
To the nearest 1/16"
To the nearest 1/32"
To the nearest 1/64" b
To the nearest 1/128"
To the nearest 1/256"

[]suppress spaces

Figure 2-35 The Format dialog box

4. Choose OK to return to the Project Units dialog box. Next, choose the OK button; the
dialog box is closed and the user interface screen is displayed.
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Setting Dimensions and Object Snaps
Next, you need to access and modify settings in the Snaps dialog box. You need to specify the
dimension snap increment and enable all object snap options.

1. Choose the Snaps tool from the Settings panel of the Manage tab; the Snaps dialog box is
displayed.

2. Inthis dialog box, enter values in the edit box below the Length dimension snap increments
check box in the Dimension Snaps area.
For Imperial  10’; 2°6”; 1°; 0°3”
For Metric 30005 7603 300; 70

3. In the Object Snaps area, ensure that all the object snaps options are selected and then
choose the OK button to apply settings and exit the Snaps dialog box.

Saving the Project

In this section, you need to save the project and the settings using the Save As tool.

1. Choose Save As > Project from the File menu. The Save As dialog box is displayed.

2. Browse to the C:\rst_2022\c02_rst_2022_tut and for imperial enter c02_Industrial-Complex_tut2
in the File name edit box (for Metric enter M_c02_Industrial-Complex_tut2). Notice that in

the File of type drop-down list, the Project Files (*.rvt) option is selected by default.

3. Choose the Save button to save the project as c02_Industrial-Complex_tut2.rvt for Imperial
(M_c02_Industrial-Complex_tut2.ruvt for Metric). The project is saved at the specified location.

Closing the Project

1. Choose the Close option from the File menu; the project gets closed.

Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1. The options in the drop-down list are used to control the symbolic display of
moment connections for cantilever framing that exists throughout a project.

2. The drop-down list in the Structural Settings dialog box contains two options:
Parallel Line and Line with Angle.

3. In Autodesk Revit, you can set the symbolic representation of structural framing components
by using the dialog box.

4. 'To specity the location of the default template file, you can use the tab in the
Options dialog box.
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10.

The button in the Save As dialog box can be used to specify the maximum
numbers of backup(s) for a project file.

The option of Revit enables you to override snap settings for a single pick only.

You can add folders to the in the Save As dialog box to access the frequently
used folders directly.

You can open only one Revit project at a time. (1/F)
In Revit, all enabled object snaps work together. (1/F)

A project file can be opened by double-clicking on its file name in the Windows Explorer.
(T/F).

Review Questions

Answer the following questions:

1.

Which of the following options is not an object snap option?

a) Endpoints b) Work Plane Grid
¢) Dimension d) Centers

Which of the following keys is used to toggle between the object snap options available at
the same point?

a) TAB b) CTRL
) ALT d) F3

You can specify the settings for ViewCube and SteeringWheels in the
dialog box.

You can select any of the three options, namely Beams and Braces, Column Base, and
Column Top from the drop-down list.

You can modify the project unit settings anytime during a project. (1/F)

The name and path of a project file should be specified each time you save the project. (1/F)
You cannot control the visibility of the tooltip assistant. (I/F)

The Save reminder interval drop-down list available in the General tab of the Options

dialog box is used to specify the time interval between reminder prompts to save a project
file. (T/F)
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9. Ifyou choose the Close button without saving the changes made in a project file, Revit will
prompt you to save the changes before closing it. (T/F).

10. You can add words to additional dictionaries for checking spelling errors. (T/F)

EXERCISES

Exercise 1 Academic Institution
In this exercise, you will create a new project file for the Academic Institution project with the
following parameters. (Expected time: 15 min)

1. Template file-
For Imperial ~ English-Imperial > Structural-Analysis Default.rte
For Metric English-Metric > Structural-Analysis DefaultMetric.rte

2. Project Units-
For Imperial  Feet and fractional inches
For Metric Millimeters

3. File name to be assigned:
For Imperial  ¢02_Academic-Institution_exerl.rut
For Metric M _c02_Academic-Institution_exerl.rut

Exercise 2 Factory Shed

In this exercise, you will create a new project file for the Factory Shed project by using the following
parameters. (Expected time: 15 min)

1. Template file:
For Imperial ~ English-Imperial > Structural-Analysis Default.rte
For Metric English-Metric > Structural-Analysis DefaultMetric.rte

2. Project Units:
For Imperial  Feet and fractional inches
For Metric Millimeters

3. File name to be assigned:
For Imperial  ¢02_Factory-Shed_exer2.rut
For Metric M_c02_Factory-Shed_exer2.rvt
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Answers to Self-Evaluation Test
1. Cantilever connection, 2. Plan representation, 3. Structural Settings, 4. File Locations,
5. Options, 6. Temporary Overrides, 7. Places list, 8. F, 9. T, 10. T



